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˺� DWG��.d�Y��Ë��{�Â»�¹Y|¯�|¿Â�a��
¦·Y� É�Zf�Â¿�ÉZÅ�¶ËZ§��
�[��� �°��Ä]��Â]�»�¶ËZ§��
�k��� É�ËÂ�e�ÉZÅ�¶ËZ§��
�{�� Ê¼Ì��e�ÉZÅ�¶ËZ§��

��
˻� �ÉÂÀ»��Y�]Y��YÂ¿��{Modify��Ä]��Â]�»�����������������d�Y����

¦·Y� ¾f»�®^��dË�Ë|»��
�[��� ZÅ�ÄËÓ�dË�Ë|»��
�k��� Ê¼Ì��e��Y�]Y��
�{�� �Â»��ËY�ËÁcZ�Â��

��
˼� �|Ì¸¯�{�°¸¼�Esc��.d�Ìq��

¦·Y� |À¯�Ê»�É�Ì³Â¸m��Âf�{�Ä»Y{Y��Y���
�[��� �|Ì¸¯�|À¿Z»Enter�d�Y���
�k��� �Âf�{�ÉY�mY��
�{�� �|Ì¸¯�|À¿Z»Spacebar�d�Y���

 
˽� �.d�Ìq�|Ë|m�¶ËZ§�{ZnËY��^¿ZÌ»�|Ì¸¯��

¦·Y� Ctrl+N 
�[��� Ctrl+Q 
�k��� Ctrl+S 
�{�� Ctrl+O 

��
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˾� ��Âf�{��������������Y�]{Á��Ê»��Z¯�Ä]�º�fÀ»�ÉZÅ�Ê ¸��|Àq�ºÌ��e�É����
¦·Y� Line 
�[��� Polyline 
�k��� Polygon 
�{�� Pedit 

��
˿� �½Z»�§��{Line��¥�u�½{�¯�`ËZe�,C���|Ì¸¯�½{��Á��.{�Ì³�Ê»�c�Â��ÊeZÌ¸¼��Äq�½Z»�§��y�ÉÂ¸m��{ 

Specify next point or [close/ undo]: C   
¦·Y� ½Z»�§�¹Zn¿Y��
�[��� �µZ�eYÄ�¬¿�¾Ì·ÁY�Ä]�Ä�¬¿�¾Ë�yM��
�k��� ¶^«�Ä¸u�»�®Ë�Ä]�d�³�Z]��
�{�� Ä¼eZy�Âf�{�É��

̀� ��Âf�{Pan��\mÂ»��������������������
¦·Y� {Â��Ê»��ËÂ�e�Äv¨��ÊËZn]Zm���
�[��� |À¯�Ê»�ÊËZ¼À³��]���
�k��� �|Ì¸¯�Ä]Z�»Esc�d�Y���
�{�� |À¯�Ê»�ÊËZ¼À³��]�Y��cZ¼Ì��e��Y�Êf¼�«���

��
́� Ì «Â»�cZ�fz»�¾ËY��{{Â��Ê»��z�»�,cZ�fz»�O|^»�Ä]�d^�¿�ÄËÁY��Á�{|��®Ë���Âe�Ä�¬¿��Å�d����

¦·Y� Êe�Z¯{��
�[��� Ê^�«��
�k��� Ê^�¿��
�{�� Ê^�«�Ê^�¿��

��
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̂� OOPS�Ä¯�d�Y�É�Âf�{����
¦·Y� ��Âf�{��{line�|À¯�Ê»�­Za�Y���y�¾Ë�yM���
�[��� ��Âf�{�ÉY�mY�¾Ë�yMErase�|À¯�Ê»��iY�Ê]�Y����
�k��� �ºÌ��e��a�Âe�ÉZÅ�Ä¬¸u|À¯�Ê»���
�{�� |À¯�Ê»�ºÌ��e�Ê·Zy�Âe�ÉZÅ�Ä¬¸u���

��
˺˹� �½Z»�§��{�ºÌ��e�µÂ���{�LY�mY�¹Z¼e�������������������|¿Y�Äq�Zb°Ë����

¦·Y� Line 
�[��� Arc 
�k��� Pline 
�{�� Circle��

��
˺˺� ��^¿ZÌ»�½{�¯�µZ §�|Ì¸¯F����Ä]��Â]�»������������������d�Y����

¦·Y� Polar 
�[��� Osnap 
�k��� Snap 
�{�� Grid 

��
˺˻� �½Z»�§��Y�cZ¼Ì��e�Ê´f�y��§��ÉY�]�����������������{Â��Ê»�Ã{Z¨f�Y����

¦·Y� Right 
�[��� �|Ì¸¯F� 
�k��� Regen��
�{�� Draw 
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�� 
˺˼� ��Âf�{��Y�,ÉY�Ä�¬¿�µÂu�Ê�Â�Â»�½Y�Á{�ÉY�]��������������{{�³�Ê»�Ã{Z¨f�Y����

¦·Y� Array 
�[��� Rotate 
�k��� Circle 
�{�� Copy 

˺˽� EndPoint��ÊÀ Ë��������������������
¦·Y����y�Ã�Za�ÉZÆf¿Y��
�[��� �y�Ã�Za���Á��
�k��� Ã�ËY{���Á��
�{�� ½Z¼¯���Á��

 
˺˾� ��Y�]Y�®¼¯�Ä¸Ì�Â]Intersection�,½YÂe�Ê»�����������������d§ZË�Y�����

¦·Y� Ã�ËY{��]���
�[��� ZÅ��Z¼» 
�k��� �y�Ã�Za�Á{���Z¬e�¶v»��
�{�� �Z¬¿ 

��
˺˿� ��Âf�{��{Trim��c�Z^��,Select cutting edges��.d�Y�ZÀ »�Äq�Ä]��

¦·Y� �Â�Â»�[Zzf¿Y��
�[��� ��]�ÉZÅ�Ä^·�¾ÌÌ e��
�k��� �Â�Â»���]��
�{�� Ä¸�Z§�¾ÌÌ e��

��
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˺̀� ��Âf�{������������������|À¯�Ê»�ÄË�ne��y�Ã�Za�É{Y| e�Ä]�É�ÅZ��¶°���¨u�Z]�Y��Äq�Zb°Ë�cZ�Â�Â»����
¦·Y� Trim 
�[��� Extend 
�k��� Break 
�{�� Explode 

��
˺́� ��Âf�{��{Extend��|ËZ]�Y|f]Y������������������{�¯�[Zzf¿Y�Y�����

¦·Y� �Â�Â»��
�[��� Ä^·��
�k��� {Y|f»Y�Ã�Y|¿Y��
�{�� ��]��Â�Â»��

��
˺̂� ��Âf�{Srretch��ÉY�]����������������{Â��Ê»�Ã{Z¨f�Y����

¦·Y� �ZÌ¬»��ÌÌ¤e��
�[��� ®^���ÌÌ¤e��
�k��� cZ�Â�Â»���¯��
�{�� ZÅ�ÊÀvÀ»�{ZnËY��

��
˻˹� �Êe�Â���{�ºÅ�Ä¯�{�¯�Ã|ÅZ�»�Y��ÄËÓ�®Ë�ÉYÂfv»�½YÂe�Ê»����������������Á���������������|�Z]����

¦·Y� Freeze - on 
�[��� Thaw � on 
�k��� Freeze - off 
�{�� Thaw - off 
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˻˺� �ÄËÓ��{��Ë���Âf�{�¹Y|¯Off�{�Y|¿�É�iY����
¦·Y� Select object → All 
�[��� Plot 
�k��� Regen 
�{�� Zoom → Extend 

��
˻˻� Ä¼Å�[Zzf¿Y�h�Z]�ÄÀË�³�¹Y|¯�.{Â��Ê»�ZÅ�ÄËÓ�É��

¦·Y� New layer 
�[��� Make curent 
�k��� Clear All 
�{�� Select All 

��
˻˼� �.{Y{�d¬]Z�»��´Ë|°Ë�Z]�Y��cZ�Â�Â»�ÉZÅ�Ê³�ËÁ�½YÂe�Ê»��Âf�{�¹Y|¯�Z]��

¦·Y� Layer 
�[��� Matchprop 
�k��� By Layer 
�{�� Current 

��
˻˽� �������Y�]Y��������.d�Y��Âf�{�¹Y|¯�Ä]��Â]�»��

¦·Y� Scale 
�[��� Offset 
�k��� Rectangle 
�{�� Mirror 
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��
˻˾� ��Âf�{��Y�cZ�Â�Â»��ZÌ¬»��ÌÌ¤e�ÉY�]����������������{Â��Ê»�Ã{Z¨f�Y����

¦·Y� Scale 
�[��� Offset 
�k��� Zoom 
�{�� Zoom All 

��
˻˿� Â��Ê»�Ã{Z¨f�Y��Âf�{�¹Y|¯��Y�ZÅ�Ä�Â³�½{�¯�{�³�ÉY�]�.{��

¦·Y� Arc ��
�[��� Fillet ��
�k��� Circle ��
�{�� Distance ��

��
˻̀� �.d�Y��Âf�{�¹Y|¯�Ä]��Â]�»�¶°��¾ËY��

¦·Y� Rectangle 
�[��� Width 
�k��� Extend��
�{�� Chamfer 

˻́� ��Âf�{�Ä¨Ì�ÁMeasure��.d�Ìq��
¦·Y� |À¯�Ê»�É�Y~´f»Ô��ÉÁZ�»�¶�YÂ§�Ä]�Y���Â�Â»�®Ë���
�[��� ÉZÅ�µÂ��Z]�Y���Â�Â»�®Ë�|À¯�Ê»�É�Y~´f»Ô���z�»���
�k��� ��Âf�{�|À¿Z»�½M�¶¼�Offset�d�Y���
�{�� �|À¿Z»Point�{�Y~³�Ê»�Ä�¬¿�,���
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��
˻̂� �d»Ô��k�{�ÉY�]ĳ��.d�Y�tÌv���f¯Y�Z¯�¹Y|¯��

¦·Y� % % d��
�[�����% % p 
�k��� % % c 
�{�� % % o 

��
˼˹� �.d�Y�tÌv��ÄÀË�³�¹Y|¯��aÂe��Â�ZÅ�½{��ÉY�]��

¦·Y� Pattern��
�[��� Solid��
�k��� Angle 
�{�� Type 

��
˼˺� �.{�¯�{ZnËY�Y��Ê¯Â¸]�½YÂe�Ê»��Âf�{�¹Y|¯�Z]��

¦·Y� Make Block 
�[��� Insert 
�k��� Wblock 
�{�� Redraw 

��
˼˻� ��Âf�{�Ä¸Ì�Â]�����������������{�¯�k�{�É�Zm�¶ËZ§��{�­Â¸]�½YÂÀ��Ä]�Y��Ê¼Ì��e�¶ËZ§�®Ë�½YÂe�Ê»����

¦·Y� Wblock 
�[��� Block 
�k��� Insert 
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�{�� Explod 
 

˼˼� ��Âf�{�ÉY�mY�Z]Format → Rename�½YÂe�Ê»���������������{Y{��ÌÌ¤e�Y�����
¦·Y� �­Â¸]�¹Z¿��
�[��� �­Â¸]��Ì�»��
�k��� d¿Â§��Â¿��
�{�� �ÄËÓ�²¿���

��
˼˽� ��Â° »�Y��¾f»�ÄÀË�³�¹Y|¯�[Zzf¿Y�,ZÅ�d¿Â§�ºÌ�Àe��{�Ä¿Á�YÁ���.|�ËÂ¿�Ê»��

¦·Y� Upside Down��
�[��� Back Wards��
�k��� Oblique Angle��
�{�� Vertical��

��
˼˾� ��Y�|�Z]�Ê¸^«�É�Y~³�Ã�Y|¿Y�ÉZÆf¿Y�É�Y~³�Ã�Y|¿Y��Å�ÉY|f]Y�Ä¯�É�Â�]�ÊaZÌa�É�Ì³�Ã�Y|¿Y�ÉY�]�����������������{Â��Ê»�Ã{Z¨f�Y����

¦·Y� Baseline 
�[��� Continue 
�k��� Align 
�{�� Style 

��
˼˿� �.|À¯�Ê»�d¯�u���a�Z]��Â»�½Z»�§�¹Y|¯�½|��µZ §�Z]��

¦·Y� Ortho 
�[��� Grid 
�k��� Polar 
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�{�� Snap 
��

˼̀� �½Z»�§��{Layer��d·Zu�,ÄÀË�³�¹Y|¯��{�,��½{Â]�É�Zm���.{Â��Ê»�¾ÌÌ e�ÄËÓ�®Ë 
¦·Y� Freez/Thaw��
�[��� Status��
�k��� Line Weight��
�{�� Line Type��

��
˼́� ��z]��{�ÄÀË�³�¹Y|¯Island detection��Y���Â�ZÅ�|¿YÂe�Ê»�,�Â�ZÅ�½Z»�§��Y�,�.|À¯�Y�mY�¶]Z¬»�¶°��ª]Z�»��

¦·Y� Customize��
�[��� Outer��
�k��� Normal 
�{�� Ignore 

 
˼̂� �½Z»�§Dim Angular�.|Å{�Ê»�¹Zn¿Y�Y��Ê¸¼��Äq���

¦·Y� �Ê·YÂf»�É�Ì³�Ã�Y|¿Y 
�[��� Y|^»�Ä�¬¿�®Ë�Ä]�d^�¿�É�Ì³�Ã�Y|¿Y 
�k��� �y�Ã�Za�Á{�¾Ì]�ÄËÁY��É�Ì³�Ã�Y|¿Y 
�{�� y�Á{�¾Ì]�É�Ì³�Ã�Y|¿Y� 

 
˽˹� .{�Y{�{�]�Z¯�Ê¿Z»�§�Äq�É�Y~³�Ä�¬¿��Y�Ã{Z¨f�Y�Z]�ÉÁZ�»�ÉZÅ�d¼�«�Ä]��Â�Â»�®Ë�ºÌ�¬e�ÉY�]���

¦·Y� Divide 
�[��� Measure 
�k��� Break 



�Ê¿Z¼fyZ��ÉZÅ�Ä�¬¿�Á�|¯ÂeY�[Zf¯�µYÂ��®¿Z] 

�½ZÆ¨�Y�½Zf�Y�½Y�¼��ÃÁ�³�ÄÅZ»����{�°¸¼����Y�³���É�YÂ�ÅZ��|Ìn»±�Ê¯�e�ÄÌ¼��  �� 
 

�{�� Trim 
��

˽˺� ��Âf�{�{�]�Z¯�c�Z^��¹Y|¯Purge�.|Å{�Ê»�½Z�¿�Y����
¦·Y� �ºWÔ��¥~u�Á�LZÌ�Y�{|n»�ºÌ��e�	�ºÌ��e�Äv¨���{ 
�[��� {|n»�ºÌ��e�|¿Â��Ê»�Ã|Ë{�Äf�°��Ä¯�ÊÀvÀ»�LZÌ�Y 
�k��� �½M��{�Ã|��Ã{Z¨f�Y�ÉZÆf¿Â§�Á�¶ËZ§�sÔ�Y 
�{�� �Ã|�¿�Ã{Z¨f�Y�ÉZÅ�ÄËÓ�¥~u�Á�¶ËZ§�ºnu�½{�¯�º¯ 

˽˻� �½YÂe�Ê»��Ë���Y�]Y�®¼¯��Y�®Ì»Y|¯�Z]��Z]�¶°��®Ë�{Y|f»Y���.{�¯�[Zzf¿Y�Y���
¦·Y� Extension 
�[��� Intersection 
�k��� Quadrant 
{��� Parallel 

���
˽˼� �ÄÀË�³�,�Y�]Y��YÂ¿��{Style��.{Â��Ê»�Ã{Z¨f�Y��Â�À»�Äq�Ä]��

¦·Y� ¶ËZ§�dË�Ë|»��
�[��� É�Ì³�Ã�Y|¿Y�Á�¾f»�®^��dË�Ë|» 
�k��� ZÅ�ÄËÓ�dË�Ë|» 
�{�� ZÅ�Ê³�ËÁ�dË�Ë|» 

��
˽˽� �cZ¼Ì�ÀeLayer��.|¿�Y{��Y�«�ÊWÂÀ»�Äq��{��

¦·Y� File��
�[��� Edit 
�k�����Format 
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�{�� Modify 
��

˽˾� ��{Â��ºÌ��e�|¯ÂeY��{�Är¿M��Å�Ä]����������������|ÀËÂ³�Ê»���
¦·Y� �ÄËÓ���Layer 
�[��� ��Â�Â»���Object 
�k��� �®^���Style 
�{�� ��Â�Â»���Properties 

��
˽˿� ��Âf�{�ÉY�mY��Y| ]�³YPoint���Âf�{DDPtype�Ã�Y|¿Y�Á�¶°��Á�Ã{�¯�Y�mY�Y�ÃZ´¿M�,|ÌÅ{��ÌÌ¤e�Y���Z¬¿�É����

¦·Y� �ÉZÅ�d»Ô�d§�³�|ÅYÂy��Y�«��ÌiPe�dve��Ì¿�Ê¸^«���
�[��� d�Y�|Ë|m�µ|»�Z]�{Â��ºÌ��e�¶¼��¾ËY��Y�| ]�Ä¯�ÉY�Ä�¬¿�d»Ô���Å� 
�k��� {Â��Ê¼¿�{ZnËY�ZÆf»Ô���{�É�ÌÌ¤e�pÌÅ� 
�{�� |À¯�Ê»��ÌÌ¤e�ZÅ�d»Ô���ËZ�� 

��
˽̀� Ê»�tÌv��,Ã|��ºÌ��e�¶°��duZ�»�Ä^�Zv»�ÉY�]��Ë���Ì�»�¹Y|¯�.|�Z]��

¦·Y� Tools → Inquiry → List ��
�[��� Modify → Inquiry → List 
�k��� Tools → Inquiry → Area  
�{�� Modify → Inquiry → Area 

��
˽́� �.{�¯�Ã{Z¨f�Y�|ËZ]�Ê°¼¯��Y�]Y�Äq��Y�ªÌ«{�0Ô»Z¯�c�Â��Ä]�cZ�Â�Â»�ÉÁ���]��Zy�Ê�Z¬¿�[Zzf¿Y�ÉY�]��

¦·Y� Object snap��������� 
�[��� End point� ����
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�k��� Cursor 
�{�� Tool bar 

˽̂� .�{�Y{�{�]�Z¯�ÄÀË�³�¹Y|¯��m�»��Â�Â»�Ze��]Y���y�Ä¸�Z§�ºÌ�Àe�ÉY�]�,É�Y~³�Ã�Y|¿Y��{���
¦·Y� spacing������ ��� 
�[��� origin �offset��
�k��� suppress 
�{�� extension���� �����    �� 

��
˾˹� �½Z»�§Explode�.d�Ì¿�Y�mY�¶]Z«��Ë��ÉZÅ�½Z»�§��Y�®Ì»Y|¯�ÉÁ���]���

¦·Y� PLine����
�[��� Poly Gon 
�k��� Circle��������������������� 
�{�� Rectangle������� 

 
˾˺� ½Z»�§��{Text style�.|¿Â��Ê»�Äf�Â¿��e�¾Æa�,�Z¨e�Y�½|¿Z»��Â¨v»�Z]�¥Á�u�,¾f»�dÌ�Zy�¹Y|¯��ÌÌ¤e�Z]���

¦·Y� Hight ������������������� 
�[��� Oblique ������������������� 
�k��� Back wards 
�{�� Width Factor ����������� 

��
˾˻� .{�¯�¶Ë|^e�ÃYÂz·{�Ã�Y|¿Y�Ä]�Y��½M�½YÂe�Ê»��Ì¤f»�¹Y|¯�Z]�,|�Z]�®qÂ¯�Ê¸Ìy�ZË�±��]�Ê¸Ìy�,Ä�¬¿��{��Â�y�ÉÂ´·Y��³Y���

¦·Y� Line style 
�[��� Ltscale 
�k��� Line scale�       
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�½ZÆ¨�Y�½Zf�Y�½Y�¼��ÃÁ�³�ÄÅZ»����{�°¸¼����Y�³���É�YÂ�ÅZ��|Ìn»±�Ê¯�e�ÄÌ¼��  �� 
 

�{�� Line type��       ���� 

˾˼� �½Â°ËM��Ê��f�{�dÆm�.|�Z]�Ê»��Âf�{�¹Y|¯�Ä]��
¦·Y� Braek 
�[��� Trim 
�k��� Extend 
�{�� Chamfer 

��
˾˽� �ÄÀË�³��Y�Ã{Z¨f�YThrough���Âf�{��{Offset��c�Â��Ä]�Y��Ê�¯�É�YÂ»�,��������������|À¯�Ê»��Ë~a�½Z°»Y�Y�����

¦·Y� Ã|��¾ÌÌ e��Ìa��Y�Ã�Y|¿Y�Z]�½Z�°Ë���Ze�� 
�[��� �Ã�Y|¿Y�¾ÌÌ e�Z]��Ì¤f»���Ze��¶^«��Y 
�k��� ½{�¯�®Ì¸¯���Âe�Ä¸�Z§�¾ÌÌ e�Z]�Êf�{ 
�{�� cZ�Â�Â»�¶yY{��¬§�É�YÂ» 

��
˾˾� �.{Â¼¿�Ã{Z¨f�Y�½YÂe�Ê»��Ë���Á��¹Y|¯��Y�,[Zzf¿Y�d·Zu��Y�cZ�Â�Â»�½{�¯�k�Zy�ÉY�]��

¦·Y� �¥�u�`ËZeR���¿�{�Â»��Â�Â»�[Zzf¿Y�Á 
�[��� �¾f�Y|Æ´¿Z]Alt�cZ�Â�Â»�ÉÁ���]�®Ì¸¯�Á 
�k��� �¥�u�`ËZeP 
�{�� Esc����������������������������������������������������� ������ 

˾˿� �d�Ì¿�Y�mY�¶]Z«��Z]�®Ë��Y��Ì]�½Z»�§�¹Y|¯����
¦·Y� Undo���������������������� 
�[��� Offset������������������������ 
�k��� Dist������� 
�{�� Redo�������������������� 
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��
˾̀� �ºÌ��e��{Donut«��³Y�,�Y��Ê¸yY{��������������®Ë�,Ä¬¸u�ºÌ��e�ÉZm�Ä]�|ÌÀ¯�{�YÁ����������|��|ÅYÂy�ºÌ��e����

¦·Y� �®Ë±�Ã�ËY{��
�[��� ��¨�±�Donut 
�k��� ��¨�±��aÂe�Ã�ËY{ 
�{�� ��¨�±�Ê�Ì] 

 
˾́� �.d�Y�ÄÀË�³�¹Y|¯�Ê¸^«��Âf�{�ÉY�mY��Á��¾Ë�e��Ë����

¦·Y� �|Ì¸¯�½{��§Enter 
�[��� Ã�Z]Á{�ÉY�mY½Z»�§�É 
k���� Ä�Â]�»�ÂÀ»�Ä]�{Á�Á 
�{�� �|Ì¸¯�½{��§Ctrl 

 
˾̂� �É����ÉÁZ�»�¶�YÂ§�Ä]�cZ�Â�Â»�É�Y{�]�Äz�¿�ÉY�]±���Âf�{��Y�Ê¿Âf��������������������{Â��Ê»�Ã{Z¨f�Y����

¦·Y� Copy 
�[��� Offset 
�k��� Array 
�{�� Rotate 

 
˿˹� ��Âf�{��{Offset��Y��ÉY�Ã�ËY{��³Y�,offset��ÃZ´¿M�,|ÌÀ¯�������������������

¦·Y� Ä¸�Z§��{{Â��Ê»�Êb¯�Ã�ËY{�Ã|��¾ÌÌ e�É���
�[��� {Â��Ê»�Êb¯�Ã�ËY{�Ã|��¾ÌÌ e�¶�YÂ§��{� 
�k��� Ä¸�Z§��{�Ã�ËY{�½M�Z]��¯�»�ºÅ�ÉY�Ã�ËY{{Â��Ê»�Êb¯��z�»�dÆm��{�Á�¾Ì »�É� 
�{�� {Â��Ê»�{ZnËY�Ã�ËY{�½M�½Á�Ì]��{��¯�»�ºÅ�ÉY�Ã�ËY{� 
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˿˺� �ÉÂÀ»��{Linetype�Ã�YÁ�É�load���.{�Y{�É{�°¸¼��Äq��

¦·Y� �y�É�Y~³�Z]��
�[��� �y�[Zzf¿Y 
�k��� �y�µ|» 
�{�� �y��ZÌ¬» 

 
˿˻� �ÄËÓ�É�Z��½ZÆÀa�c�|«��������������������ÄËÓ�Ä]�d^�¿�Ã|��������������������d�Y��f�Ì]��ZÌ�]����

¦·Y� Thaw - Freeze 
�[��� on - Freeze 
�k��� on - Thaw 
�{����off � Freeze 

 
 

˿˼� ��{Auto cad Äf�{�®Ë�ÉÁZu�ÂÀ»��Å�,��Y��Zy�É���������������d�Y����
¦·Y� ZÅ�¶°� 
�[��� ZÅ�Ä�¬¿ 
�k��� ZÅ�Âf�{ 
�{�� ZÅÂ´·Y 

��
˿˽� �UCS��ÊÀ Ë����

¦·Y� cZ�fz»�ÃZ´f�{�d»Ô���
�[��� �³�Á�»��YÂ¿ 
�k��� Ã�nÀacY�Âf�{�É 
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�{�� Z¼¿�½Z°» 
��

˿˾� �ÉZÅ|Ì¸¯�½Z»�¼Å�½{��§�c�Â���{Ctrl+S�»�§�Äq�.{{�³�Ê»�Y�mY�Ê¿Z��
¦·Y� QSave 
�[��� Osnap 
�k��� Grid 
�{�� Print 

��
˿˿� ��|Ì¸¯��Âf�{�®Ë�ÉY�mY�Ä»Y{Y��Y�É�Ì³Â¸m�ÉY�]�����������������|ÌÅ{��Z�§�Y�����

¦·Y� Enter 
�[��� Spacebar 
�k��� Esc 
�{�� F� 

 
˿̀� ��{Auto Cad��|Ì¸¯�½{��§Enter��Á����������������¹ÂÆ¨»�ÉY�Y{�0Z»Â¼��,�d�Y�Ê¿Z�°Ë����

¦·Y� Esc 
�[��� Space bar 
�k��� F� 
�{�� F� 

��
˿́� �.d�Y�tÌv���Ë���Ì�»�¹Y|¯��Y�]Y��YÂ¿�®Ë�¥~u�ZË�½{�¯�µZ §�ÉY�]��

¦·Y� Toolbars  customize��
�[��� Toolbars  zoom 
�k��� Zoom  window 
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�{�� Zoom  limits 
��

˿̂� ��|Ì¸¯��Y�Ã{Z¨f�Y�Z]F��.{Â��Ê»�Y�mY�ÄÀË�³�¹Y|¯���
¦·Y� �Ã�nÀaText�{Â��Ê»�Ã{Y{��ËZ¼¿�½Z»�§��y�Ä]��Â]�»���
�[��� �½Z»�§Text�{Â��Ê»�¹Zn¿Y���
�k��� �½Z»�§Dtext�{Â��Ê»�¹Zn¿Y���
�{�� �½Z»�§Mtext�{Â��Ê»�¹Zn¿Y���

̀˹� ��Âf�{��YNew��ÉY�]�����������������{Â��Ê»�Ã{Z¨f�Y�|Ë|m�Ê¼Ì��e�¶ËZ§�®Ë����
¦·Y� ®^���
�[��� {ZnËY 
�k��� ¥~u 
{��� �ÌÌ¤e 

��
̀˺� �½Z»�§�ÉY�mY�Z]Open����������������������

¦·Y� {Â��Ê»��Z]�|Ë|m�¶ËZ§���
�[��� {Â��Ê»��Z]�{ÂmÂ»�¶ËZ§���
�k��� {Â��Ê»�{ZnËY�|Ë|m�¶ËZ§� 
�{�� {Â��Ê»��Z]�®Ë�f»�|uYÁ��Z�Y��]�¶ËZ§� 

��
̀˻� �.d�Ìq�{ÂmÂ»�¶ËZ§�®Ë�½{�¯��Z]��^¿ZÌ»�|Ì¸¯��

¦·Y� Ctrl + N��
�[��� Ctrl + Q 
�k��� Ctrl + O 



�Ê¿Z¼fyZ��ÉZÅ�Ä�¬¿�Á�|¯ÂeY�[Zf¯�µYÂ��®¿Z] 
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�{�� Ctrl + P 
��

̀˼� �.{Â��Ê»�Y�mY�½Z»�§�¹Y|¯�,|¯ÂeY�Ä»Z¿�]��Y�kÁ�y�ÉY�]��
¦·Y� Ctrl + Z 
�[��� Alt + F� 
�k��� Ctrl + Y 
�{�� Alt + F� 

��
̀˽� �.d�Y�{�Â»�¹Y|¯��´¿Z�¿����������d»Ô���

¦·Y� Line��
�[��� Circle 
�k��� Ellipse 
�{�� Arc 

��
̀˾� ��Âf�{�ÉY�mY��Y��aLine���{�.|ÌÀÌ]�Ê»�Ê»ZÌa�Äq�½Z»�§��y��

¦·Y� Specify frirst point 
�[��� Select object 
�k��� Specify next point 
�{�� Close 

��
̀˿� �¥�u��Ë��¹Z¤Ìa��{��³Yu��Á�`ËZe�Y�Enter��.|f§Y�Ê»�Ê«Z¨eY�Äq�,|Ì¿�]�Y� 

�specify next point or [close / undo]:���
¦·Y� �½Z»�§�¹Zn¿Y 
�[��� Ä]�d�³�Z]�¶^«�Ä¸u�»�®Ë 
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�k��� Ä�¬¿�¾Ì·ÁY�Ä]�Ä�¬¿�¾Ë�yM�µZ�eY 
�{�� Ä¼eZy�Âf�{�É 

̀̀� Ä¸Ì�Â]��Âf�{�É����������������{Y{��ÌÌ¤e�ZË�Á�¦Ë� e�Y��ºÌ��e���§��Ìa�ÉZÅ�Ã{Á|v»�½YÂe�Ê»����
¦·Y� Pan��
�[��� Zoom 
�k��� Limits 
�{�� Grid 

��
̀́� z�»�{|��d¨m�®Ë���Âe�Ä�¬¿��Å�dÌ «Â»�cZ�fz»�¾ËY��{{Â��Ê»������

¦·Y� Êe�Z¯{��
�[��� Ê^�« 
�k��� Ê^�¿ 
�{�� Ê^�«�Ê^�¿ 

��
̀̂� �.{Â��Ê»�¾ÌÌ e�cZ�fz»�ÃZ´f�{�LY|^»�Ä]�d^�¿�Ä�¬¿�dÌ «Â»�cZ�fz»�¹Y|¯��{��

¦·Y� Êe�Z¯{��
�[��� Ê^�« 
�k��� ª¸�» 
�{�� Ê^�¿ 

��
́˹� Ã�Y|¿Y��Ë��{�Â»�¹Y|¯��{�.|À¯�Ê¼¿��ÌÌ¤e�ºÌ��e�É��

¦·Y� Zoom 
�[��� Scale 
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�k��� Strech 
�{�� Scale: ��� 

��
́˺� �.|À¯�Ê»�­Za�Y��cZ�Â�Â»��Ë���Âf�{�¹Y|¯��

¦·Y� Off 
�[��� Freeze 
�k��� Layer - off 
�{�� Erase 

��
́˻� �¹Z¿�Ä]�É�Âf�{��Y�Ê�y�|Àq��ËY�ËÁ�ÉY�]���������������{Â��Ê»�Ã{Z¨f�Y����

¦·Y� EDIT 
�[��� UNDO 
�k��� PEDIT 
�{�� REDO 

 
́˼� �½Z¼¯�ºÌ��e��{S , C , E��.d�ZÀ »�Äq�Ä]��

¦·Y� �½Z¼¯��Á���Ä�¬¿±��½Z¼¯��¯�»±�Ä�¬¿�½ZËZa�É��
�[��� �½Z¼¯��¯�»±�Ä�¬¿��Á���É±�Ä�¬¿½ZËZa�É 

�k��� �½Z¼¯�ÄËÁY�±���Z �±�Ä�¬¿½ZËZa�É 
�{�� ��Z �±��½Z¼¯�ÄËÁY�±�Ä�¬¿½ZËZa�É 

��
́˽� ÄÀË�³�,¶Ì�f�»�ºÌ��e�½Z»�§��{�ÉDimensions��,¹Á{�cZ�fz»�ÉZm�Ä]�,����������������������|À¯�Ê»�µYR��Y�����

¦·Y� ¶Ì�f�»�����Á�µÂ���
�[��� �ZÅ�µÂ���Âv»�ÉZf�Y���{�¶Ì�f�»�{Z ]Y�Y|f]Y 
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�k��� �ZÅ������Âv»�ÉZf�Y���{�¶Ì�f�»�{Z ]Y�Y|f]Y 
�{�� �¶Ì�f�»�duZ�»�Ã�Y|¿Y 

��
́˾� �.d�ZÀ »�Äq�Ä]����������½Â°ËM��

¦·Y� Line��
�[��� Polygon��
�k��� Rectangle 
{��� Polyline 

��
́˿� �[Zzf¿Y�Z]Fillet��¶Ì�f�»�ÉZÅ�Ä�Â³�����������������{Â��Ê»����

¦·Y� {�³��
�[��� xa 
�k��� ºÌz� 
�{�� ¾Æa 

��
́̀� �.d�Y�tÌv��ÄÀË�³�¹Y|¯�º�fÀ»�Ê ¸��|Àq�ºÌ��e��Âf�{��

¦·Y� Polygon 
�[��� Polyline 
�k��� Line 
�{�� Fillet 

��
́́� Ä¼¯{�½{Â]�µZ §�c�Â���{�ÉORTHO�Ê¸¼��Äq��.{Â��Ê»�¹Zn¿Y��

¦·Y� ÄËÁY��ºÌ��e�É35��
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�[��� ÄËÁY��ºÌ��e�É90��
�k��� {Y�M�ÄËÁY��ºÌ��e 
�{�� ÄËÁY��ºÌ��e���Y�Ê]��»�Z]35��

��
́̂� ��^¿ZÌ»�|Ì¸¯F��ÄÀË�³�¹Y|¯�Ä]��Â]�»�.d�Y��Ë��É��

¦·Y� Grid��
�[��� Polar 
�k��� Ortho��
�{�� Osnap 

 
̂˹� �|Ì¸¯�½{�¯�µZ §�Z]Ortho��|Ì¸¯�,�����������������{Â��Ê»�µZ §�Ì£����

¦·Y� Polar 
�[��� Osnap 
�k��� Snap 
�{�� Grid 

��
̂˺� ÄÀË�³�ÉZoom � all��.|À¯�Ê»�µZ^¿{�Y��Ê§|Å�Äq��

¦·Y� {Â��Ê»�Ã|Ë{�cZ�Â�Â»�Ê»Z¼e���
�[��� Ã{Á|v»��{�cZ�Â�Â»�Ê»Z¼e»�|u�Ze�ºÌ��e�É{Â��Ê»�±��]�¾°¼� 
�k��� |��|ÅYÂy�±��]�{Ây��Y|¬»�¾Ë�f³��]�Ä]�ºÌ��e��Y�Êf¼�«� 
�{�� Ã�Y|¿Y�Ä]��¬§Ã�nÀa�É�Écrossing�|��|ÅYÂy�±��]��Â�Â»���

��
̂˻� �½Z»�§��Y�Ã�ËY{�Á�½Z¼¯�Ê´f�°��¶°�»��§��ÉY�]������������������{Â��Ê»�Ã{Z¨f�Y����

¦·Y� Right 



�Ê¿Z¼fyZ��ÉZÅ�Ä�¬¿�Á�|¯ÂeY�[Zf¯�µYÂ��®¿Z] 
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�[��� Bilps 
�k��� Regen 
�{�� Draw 

��
̂˼� �.|À¯�Ê»��ÌÌ¤e�É�Zm�cZ�fz»�ÃZ´f�{�Ä]�d^�¿�0Z «YÁ�Ê]Zzf¿Y��Â�Â»�dÌ «Â»��Ë���Âf�{�¹Y|¯��{��

¦·Y� Zoom 
�[��� Pan 
�k��� Move 
�{�� Window 

��
̂˽� �.|�Z]�Ê»�½Z»�§�¹Y|¯�Ä]��Â]�»�����������Y�]Y��YÂ¿��

¦·Y� Pan 
�[��� Rotate 
�k��� Scale 
�{�� Array 

��
̂˾� �tÌv��ÄÀË�³�¹Y|¯�.d�Y��

¦·Y� �cÁZ¨ecopy��Ámove�Äz�¿��¨u��{d�Y��Â�Â»�Ê¸�Y�É���
�[��� �ÉZÆ¿Z»�§copy��Ámove�|Àf�Å�ºÅ�Ä]�ÄÌ^��0Ô»Z¯���
�k��� copy��Ámove�|ÀÅ{�Ê»�¹Zn¿Y�Y��cZ�Â�Â»�ÊËZn]Zm�¶¼�� 
�{����copy��Ámove�|ÀÅ{�Ê»�¹Zn¿Y�ÊËZn]Zm�|Àq�Á{��Å� 

��
̂˿� Copy���Âf�{�®Ë����������������d�Y����
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¦·Y� Ê�ËY�ËÁ��
�[��� Ê¼Ì��e 
�k��� �®^�(style) 
�{�� ÊeZ�Ô�Y 

��
̂̀� �É����ÉÁZ�»�¶�YÂ§�Ä]�cZ�Â�Â»�É�Y{�]�Äz�¿�ÉY�]±���Âf�{��Y�Ê¿Âf��������������������{Â��Ê»�Ã{Z¨f�Y����

¦·Y� Copy 
�[��� Offset 
�k��� Array 
�{�� Rotate 

��
̂́� .d�Y�¹Y|¯�½Z»�§�¾Ë�fÆ]�É�YÂ»�ÉZÅ�Êb¯�{ZnËY�ÉY�]���

¦·Y� Copy ��
�[��� Offset  
�k��� Array  
�{�� Move  

��
̂̂� ��Âf�{��{Offset��Y��ÉY�Ã�ËY{��³Y�,Offset��,ÃZ´¿M�|ÌÀ¯�������������������

¦·Y� Ä¸�Z§��{{Â��Ê»�Êb¯�Ã�ËY{�Ã|��¾ÌÌ e�É��
�[��� {Â��Ê»�Êb¯�Ã�ËY{�Ã|��¾ÌÌ e�¶�YÂ§��{ 
�k��� Ä¸�Z§��{�Ã�ËY{�½M�Z]��¯�»�ºÅ�ÉY�Ã�ËY{�É{Â��Ê»�Êb¯��z�»�dÆm�Á��{�Á�¾Ì »� 
�{�� {Â��Ê»�{ZnËY�Ã�ËY{�½M�½Á�Ì]��{��¯�»�ºÅ�ÉY�Ã�ËY{ 

��
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˺˹˹� �sÔ��Y�Object snap��ÊÀ Ë����
¦·Y� ZÅ�Y�]Y�®¼¯��
�[��� �Z¬¿�¾Ì]�¶�YÂ§ 
�k��� �Â»���a 
�{�� ÉÁZ�»�¶�YÂ§�Z]�ºÌ��e 

��
˺˹˺� �sÔ��Y�Midpoint��ÊÀ Ë����

¦·Y� ºÌ��e�ÉZÆf¿Y��
�[��� �Ã�Za���Á�y 
�k��� Ã�ËY{���Á 
�{�� ½Z¼¯���Á 

��
˺˹˻� ��Y�]Y�®¼¯�Ä¸Ì�Â]����������������d§ZË�Y���y�Ã�Za�Á{�{�Ây�]�¶v»�½YÂe�Ê»����

¦·Y� End point 
�[��� Mid point 
�k��� Inter section 
�{�� Node 

��
˺˹˼� ½Z»�§�Ä]��Â]�»�����������½Â°ËM����������������d�Y����

¦·Y� Extend 
�[��� Trim 
�k��� Break 
�{�� Point 
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˺˹˽� ��Âf�{Break�d�Y��Ë���Âf�{�¹Y|¯�Ä]Z�»����
¦·Y� Extend 
�[��� Trim 
�k��� Point 
�{�� Move 

��
˺˹˾� ��Âf�{������������|À¯�Ê»��Y�«�]��´Ë{��Â�Â»�|Àq�ZË�®Ë�Ä]�d^�¿�Y���Â�Â»�½{Y{���]�½Z°»Y�����

¦·Y� Extend 
�[��� Point 
�k��� Break 
�{�� Trim 

��
˺˹˿� �®ËPolygon�Y���.{�¯�ÄË�ne��y�Ã�Za�É{Y| e�Ä]�½YÂe�Ê»��Âf�{�¹Y|¯�Z]��

¦·Y� Break 
�[��� Explod 
�k��� Extend 
�{�� Trim 

��
˺˹̀� Ä^·�Ä]�Ze�|À¯�Ê»�Y|Ìa�Ä»Y{Y��y�Ã�Za��Âf�{�¹Y|¯�Z]|��]���¿�{�Â»�É����

¦·Y� Break ��
�[��� Explod  
�k��� Extend  
�{�� Trim  
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��
˺˹́� ��Y��Â�À»������������������Ê´¿��|»M�|ÀÅYÂy�{ÂmÁ�Ä]�½M��Z�Y��]�|Ë|m�cZ�Â�Â»�Ä¯�d�Y����

¦·Y� É�Zm�²¿���
�[��� �¨��ÄËÓ�²¿� 
�k��� Ê¸^«�ÄËÓ�²¿� 
�{�� ZÅ�YÂË{�ÄËÓ�²¿� 

��
˺˹̂� ���Âf�{��Y��Y�Ã|¿�Z��ÉY�mY�Ä]�­Â¸]�ÄË�ne�ÉY�]�����������������.{Â��Ê»�Ã{Z¨f�Y��

¦·Y� Rename��
�[��� Break 
�k��� Trim 
�{�� Explode 

��
˺˺˹� ��½YÂe�Ê»�Y��É�Zm�É�ÄËÓ�����������������½YÂe�Ê¼¿�Ê·Á�{�¯�����������������{�¯����

¦·Y� Thaw - on 
�[��� Freeze - on 
�k��� Freeze - off 
�{�� Thaw - off 

��
˺˺˺� �ÄËÓ�ÉOff��.{�Y{��iY��Ë���Âf�{�¹Y|¯��{�Ã|���

¦·Y� Plot 
�[��� Print 
�k��� Regen 
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�{�� Ê¼Ì��e�cY�Âf�{ 
��

˺˺˻� ÄÀË�³�¹Y|¯{Á��Ê»��Z¯�Ä]�|Ë|m�ÄËÓ�®Ë�{ZnËY�ÉY�]��Ë��É����
¦·Y� New Layer��
�[��� Make Current 
�k��� Clear All 
�{�� Select All 

��
˺˺˼� Ä¸Ì�Â]��Âf�{�É�����������������{Y{�d¬]Z�»��´Ë|°Ë�Z]�Y��cZ�Â�Â»�ÉZÅ�Ê³�ËÁ�½YÂe�Ê»����

¦·Y� Layer 
�[��� Matchprop 
�k��� By Layer 
�{�� Current 

��
˺˺˽� �.d�Y��Â�Â»�É�Z��ÄÀË�«�Ä]��Â]�»��Âf�{�¹Y|¯��

¦·Y� Scale 
�[��� Offset 
�k��� Rectangel 
�{�� Mirror 

��
˺˺˾� ��.|ÌÀ¯�Ê»�Ã{Z¨f�Y�ÄÀË�³�¹Y|¯��Y�,|ÌÀ¯�ºÌ��e�Ê·Zy�Âe�Y��ZÀÆa�ÉY�Y{�Ê�y�|Àq�®Ë�|ÌÅYÂz]��³Y��

¦·Y� Fill  on 
�[��� Fill  off 
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�k��� �Solid  on 
�{�� Solid  off 

��
˺˺˿� �.d�Y�Äf§���Z¯�Ä]�É�Âf�{�Äq�Á�]Á��¶°���{��

¦·Y� Chamfer 
�[��� Fillet 
�k��� Offset 
�{�� Fill - off 

��
˺˺̀� Ä^�Zv»�ÉY�]��Âf�{��Y�¶Ì�f�»�®Ë�duZ�»�É����������������{Â��Ê»�Ã{Z¨f�Y����

¦·Y� ID ��
�[��� Dist  
�k��� List  
�{�� Area  

��
˺˺́� ��[Zzf¿Y��³YChamfer  distance��.d�Y�tÌv��ÄÀË�³�¹Y|¯�,|Ì�Z]�Äf�Y{�Y���

¦·Y� Ã�Y|¿Y{Â���z�»��¸��®Ë��{�½{��xa�Ä¸�Z§�É���
�[��� Ä¸�Z§�Ã�Y|¿YÄËÁY��Á�xa�®Ë�É{Â��Ê»��z�»�xa�É� 
�k��� Ä¸�Z§�Ã�Y|¿Y{Â��Ê»��z�»��¸��Á{��{�½{��xa�É� 
�{�� Ã�Y|¿YÄËÁY��É{Â��Ê»��z�»�xa�É� 
˺˺̂� Y��{Z«��Âf�{�¾ËY|À¯�É�Y~´f»Ô��ÉÁZ�»�{Y| e�Ä]�Y���Â�Â»�®Ë�d�����

¦·Y� Point 
�[��� Point  Size 
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�½ZÆ¨�Y�½Zf�Y�½Y�¼��ÃÁ�³�ÄÅZ»����{�°¸¼����Y�³���É�YÂ�ÅZ��|Ìn»±�Ê¯�e�ÄÌ¼��  �� 
 

�k��� Offset 
�{�� Divide 

��
˺˻˹� ���y�Ã�Za�®Ë����cZ �«�Ä]�Y��Êf¿Z���{Â��Ê»�Ã{Z¨f�Y��Ë���Âf�{�¹Y|¯��Y�ºÌÀ¯�ºÌ�¬e�Êf¿Z�����

¦·Y� Block��
�[��� Measiure 
�k��� Divide 
�{�� Insert 

��
˺˻˺� ���Âf�{��{Text  style���.d�Y�tÌv��ÄÀË�³�¹Y|¯��

¦·Y� ½|Ìq��Á���
�[��� ¾f»�dÌ «Â» 
�k��� ÃYÂz·{�¾f»�®^� 
�{�� Ä�¬¿�Á���É 

��
˺˻˻� ��.d�Y�tÌv���f¯Y�Z¯�¹Y|¯�Äm�{�d»Ô��k�{�ÉY�]��

¦·Y� % % d 
�[��� % % p 
�k��� % % c 
�{�� % % u 

��
˺˻˼� ���Âf�{��{Hatch  Solid�{Â��Ê»�Ã{��Êe�Â��Äq�Ä]��Â�ZÅ�,�.��

¦·Y� �É�ÄËÁY��Z]90��
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�[��� �Ê³��]�Z]���� 
�k��� �aÂe��Â�ZÅ 
�{�� Ê·ZyÂe��Â�ZÅ 

 
˺˻˽� ���Âf�{��{��³YHatch�Ä¿Z]��,�ÉAdvanced�ÄÀË�³�ÉNormal�.d�Y�d��{��Ë��{�Â»�¹Y|¯�,|ÌÀ¯�[Zzf¿Y�Y� 

�Hatch  Advanced  Normal 
¦·Y� Â��Ê»�[Zzf¿Y�½ZÌ»��{�®Ë��Â�Â»|¿��Ê»��Â�ZÅ�Á�{���
�[��� {�Ây�Ê»��Â�ZÅ��Â�Â»�¾Ë�e�Êm�Zy� 
�k��� Ä¼Å{�Ây�Ê»��Â�ZÅ��Â�Â»�É� 
�{�� {�Y{��Â�Â»��Â¿�Ä]�Ê´f�]� 

��
˺˻˾� ��.|��|ÅYÂy�ÊËÂm�Ä§���¶ËZ§�ºnu��{��Âf�{�¹Y|¯�Z]��

¦·Y� Offset 
�[��� Hatch 
�k��� Fillet 
�{�� Block 
˺˻˿� ��Ä¸Ì�Â]����������������­Â¸]�½YÂe�Ê»�{�¯�k�{�Y�����

¦·Y� Make 
�[��� Explod 
�k��� Insert 
�{�� Delete 

��
˺˻̀� ��.{Â��Ê»�Ã{Z¨f�Y�ÄÀË�³�¹Y|¯��Y�­Â¸]�¹Z¿��ÌÌ¤e�ÉY�]��

¦·Y� Format  Rename 
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�[��� Insert 
�k��� Make 
�{�� Erase 

��
˺˻́� ��.{Â��`ËZe�É�Ìq�Äq�½Z»�§��y��{�­Â¸]��Y�Ê¼Ì��e�¶ËZ§�®Ë�{ZnËY�ÉY�]��

¦·Y� Insert 
[���� Make 
�k��� Delete 
�{�� Wblock 

��
˺˻̂� ��.{Â��Ê»�Ã{Z¨f�Y��Âf�{�¹Y|¯��Y�Ä�¬¿�Á{�¾Ì]�Ä¸�Z§�Ä^�Zv»�ÉY�]��

¦·Y� List 
�[��� Dist 
�k��� Block 
�{�� Inquriy 

��
˺˼˹� ��.{Â��Ê»�Ã{Z¨f�Y�ÄÀË�³�¹Y|¯��Y�½Z�°Ë�O|^»�Z]�ÊaZÌa�É�Ì³�Ã�Y|¿Y�ÉY�]��

¦·Y� Dim  Base line 
�[��� Dim  continue 
�k��� Dim  Aligne 
�{�� Dim  style 

 
˺˼˺� ��.d�Y��fÆ]�ÄÀË�³�¹Y|¯�Ã�ËY{��Z ��É�Y~³�Ã�Y|¿Y�ÉY�]��

¦·Y� Dim  Diameters 
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�[��� Dim  style 
�k��� Dim  Redius 
�{�� Dim  Aligne 

��
˺˼˻� �Dimention line�.d�Y�ÄÀË�³�¹Y|¯��

¦·Y� Ã�Y|¿Y��y��
�[��� {Y|f»Y��y 
�k��� �¸§ 
�{�� O|^»�Ã�Y|¿Y 

��
˺˼˼� ��ÄÀË�³Dim  Leader��.|Å{�É�¹Zn¿Y�É�Z¯�Äq��

¦·Y� Z¼ÀÅY���y��
�[��� Ã�Y|¿Y��y 
�k��� {Y|f»Y��y 
�{�� É�Ì³�Ã�Y|¿Y�O|^» 

��
˺˼˽� .{�¯�¶Ë|^e�ÃYÂz·{�Ã�Y|¿Y�Ä]�Y��½M�½YÂe�Ê»��Ì¤f»�¹Y|¯�Z]�,|�Z]�®qÂ¯�Ê¸Ìy�ZË�±��]�Ê¸Ìy�,Ä�¬¿��{��Â�y�ÉÂ´·Y��³Y���

¦·Y� Line style 
�[��� Ltscale 
�k��� Line scale�       
�{�� Line type��       ���� 

 
 
��
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˺˼˾� .�{Â��Ê»�\�¿�¶»Z¯��Â�]�Ä»Z¿�]�,�|¯ÂeY��Y�§Y�¹�¿�\�¿�d·Zu�¹Y|¯��{ 

¦·Y�typical����������������������������[��full������������������������k����compact���������������������{��custom 

˺˼˿� �ÉZÅ�ÄÀË�³��Y�®Ì»Y|¯�Ä¸�Z§�Ä^ËY�Ä�¬¿�´¿ZÌ]��Ë��
��Ê¸^«�Ä�¬¿��Y���.�|�Z]�Ê»��Âv»�Z]�Äm�{��

¦·Y������
����������������������������[���
�������������������������k������
��#�����������������������{���
������#��

˺˼̀� ��Y��Â�À»C.S.L�.�d�Y�¹Y|¯�½{�¯�{�YÁ�,Ã�ËY{�ºÌ��e��{��

¦·Y���eÁ�µÂ�,�¯�»,�Á��������������[���eÁ�µÂ�,�Á��,�¯�»������������k��ÄËÁY�,�Á��,�¯�»��������������������{��½Z¼¯{Y|f»Y,�Á��,�¯�»��

˺˼́� �Y�Â�À»�point���.�d�Y�¹Y|¯�½{�¯{�YÁ,�Ã�ËY{�ºÌ��e�{��

¦·Y����«�ÉZÆf¿YÁY|f]Y�����������������[����Z ��ÉZÆf¿YÁY|f]Y��������������k���Z ��Á��¯�»������������������������{���»��«�Á��¯��

˺˼̂� ��Âf�{ELLIPSE�.�{Á��Ê»��Z°]�ÄÀË�³�¹Y|¯�ºÌ��e�dÆm��

¦·Y��Ã�ËY{�������������������������������[��Ê ¸�|Àq�����������������������k���ÊÀvÀ»��Â�y����������������������{��Ê�Ì]��

˺˽˹� ��Âf�{�{�]�Z¯trim�.�d�Y�¹Y|¯��

¦·Y���Â�Â»��Y�Êf¼�«���]������������������������������������������������[���z�»�Ä^·�Ä]�ÄmÂeZ]��Â�Â»�Y�Êf¼�«���]��
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k��Â�Â»�Y�Êf¼�«{Y|f»Y���������������������������������������������������{���z�»�Ä^·�Ä]�ÄmÂeZ]��Â�Â»�Y�Êf¼�«�{Y|f»Y��

˺˽˺� .�{Â��Ê»�Ã{Z¨f�Y�ÄÀË�³�¹Y|¯�Y,��´Ë{�Ê»Z¿Z]�¶ËZ§�Ã�Ìy}Á�Ê¸^«�ÉZÅ�Ä�¬¿�{��ÌÌ¤e�ÉY�]��

¦·Y�Save as������������������������[�Open���������������������������k�New�����������������������������������{��Save��

˺˽˻� .�{Â��Ê»�Ã{Z¨f�Y�É�Âf�{�Äq�Y|¯ÂeY�Ä»Z¿�]�Y�kÁ�y�dÆm��

¦·Y��New���������������������������[2��Exit����������������������������k����Quit����������������������������������{��Save as��

˺˽˼� �.�d�Y�¹Y|¯�Ê^�«�Ê^�¿�cZ�fz»�Ê¸¯�¶°��P�Á�µÂ�Ө��ÄËÁY����

¦·Y��Ө �,P������������������������[��Ө���P��������������������������k����P��Ө�#�����������������������������{��Ө���P���#��

˺˽˽� �Ê¸¯�¶°��ÉY�Y{�cZ�fz»�¹Y|¯Y��ÁX���.�d�Y��

¦·Y�����Ê^�¿�cZ�fz»������������[���cZ�fz»ª¸�»������������������k��Ê^�«�cZ�fz»���������������������������{��Êe�Z¯{�cZ�fz»��

˺˽˾� �d·ZuTTR��ÉY�]��.�|�Z]�Ê»�ÄÀË�³�¹Y|¯��Y�Ã{Z¨f�Y�Z]�Ã�ËY{�ºÌ��e��

¦·Y����¯�»,��Z ���������������[���¯�»,���«���������������������������k���Ä�¬¿�Ä������������������������������{���Z¼»,��Z¼»���Z �,��

˺˽˿� Redo��Âf�{�Z]|Àq�Ze���Undo�.�|À¯�Ê»�ÊjÀy�Y���
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¦·Y���®Ë��������������������[��Á{�����������������������������������k��|�������������������������������������{��{�Y|¿�dË{Á|v»��

˺˽̀� �{Â��Ê»�Ã{Z¨f�Y|¯ÂeY��{�É�Y~³�Ã�Y|¿Y�ÉY�]�Âf�{�¹Y|¯�Y�.��

¦·Y��Diameter�����������[�D text�����������������������������k����Dim�������������������������������{��Text��

˺˽́� ���Âe�Ã|��¥~u�cZ�Â�Â»�¾Ë�yM�½YÂe�Ê»,��Âf�{�¹Y|¯���ÂeErase�.|¿Y{�³�Z]�Ä�¬¿�Ä]�Y���

¦·Y��Redraw����������[�Redo�����������������������������k����Regen�������������������������������{��oops��

˺˽̂� �³�¹Y|¯��Âf�{��{�ÄÀËGrid���.�d�Ì¿�tÌv���

¦·Y���|ËZ¼¿�Ê»�ºÌ�Àe��z�»�Ä¸�Z§�Ä]Y��É|À]�Ä°^���Z¬¿����������������������������������[��|ËZ¼¿�Ê»�¥~uY��É|À]�Ä°^���Z¬¿���

k��|ËZ¼¿�Ê»�ºÌ�Àe�É{Â¼�Á�Ê¬§YY��É|À]�Ä°^���Z¬¿�����������������������������{��|Ì¸¯�®¼¯�Ä]F���Ê»Y��ºÌ�Àe�d·Zu{Y{�ÌÌ¤e�½YÂe���

˺˾˹� ��Âf�{Ray��º���dÆm�������������������{Á��Ê»��Z¯�Ä]���

¦·Y����y�ºÌ¿�������������������������[���y����������������������������������k����y�Ã�Za����������������������������������{���Z ���

˺˾˺� �ÄÀË�³Inscribed in circle����Ê ¸��|Àq�º���\mÂ»����������������Ê»��{Â����

¦·Y��Ã�ËY{��]��Ìv»�����������������[��Ã�ËY{��Z ��ºÅ����������������������k���Ã�ËY{��{��Zv»�����������������������{���Ã�ËY{��]��Z¼»��
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